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4 Read This First

Read This First
Disclaimer
• While every effort has been made to ensure that the information contained in this 

guide is accurate and complete, no liability can be accepted for any errors or 
omissions. Canon reserves the right to change the specifications of the hardware 
and software described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a 
retrieval system, or translated into any language in any form, by any means, 
without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data 
due to mistaken operation or malfunction of the camcorder, the software, memory 
cards (SD, SDHC and miniSD Cards), personal computers, or peripheral devices, 
or due to use of a memory card not initialized by a Canon camcorder.

Trademark Acknowledgments
• QuickTime is a trademark of Apple Inc., registered in the U.S. and other 

countries.
• Microsoft, Windows, Windows Media and Windows Vista are trademarks or 

registered trademarks of Microsoft Corporation in the United States and/or other 
countries.

• ,  and  are trademarks of SD Card Association.
• Other names and products not mentioned above may be registered trademarks 

or trademarks of their respective companies.
© Canon Inc. 2008 All rights reserved.

Safety Precautions
Do not play the supplied CD-ROM(s) in any CD player that does not support data 
CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could 
damage the speakers. It is also possible to suffer from hearing loss from listening 
with headphones to the loud sounds of a CD-ROM played on a music CD player.

Checking Supplied Accessories
Use the following accessories to download recorded still images from a memory card 
to your computer.

• Supplied USB cable
The cable supplied with your 
camcorder may be different from the 
one described in this manual.

• DIGITAL VIDEO Solution Disk

The explanations in this manual use mainly Windows XP screen shots. The steps 
and windows may vary depending on your computer and the version of software.
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System Requirements
Install the software on a computer meeting the following minimum requirements.

Proper operation is not guaranteed on a dual CPU PC or on a user-built PC. 
Proper operation is not guaranteed on any particular system, even if it meets 
the requirements outlined above. 
A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

OS: Windows Vista
Windows XP (Service Pack 2)
Windows 2000 (Service Pack 4)
* Proper operation is not guaranteed on an OS that has 

been upgraded from a previous version. 
Computer Model: Computers that come with above OS preinstalled and 

have built-in USB ports.
CPU: Windows Vista: Pentium 1.3 GHz or better

Windows XP/Windows 2000: Pentium 500 MHz or better
RAM: Windows Vista: 512 MB or more

Windows XP/Windows 2000: 256 MB or more
Interface: USB: only preinstalled Windows Vista/Windows XP/

Windows 2000 systems with built-in USB ports 
Free Hard Disk Space: • Canon Utilities

- ZoomBrowser EX: 200 MB or more 
• Canon DV TWAIN Driver: 25 MB or more

Display: 1024 × 768 pixels or better/High Color (16 bit) or better

Microsoft Windows Vista: Windows Vista
Microsoft Windows XP (Service Pack 2): Windows XP
Microsoft Windows 2000 (Service Pack 4): Windows 2000CO
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6 What is Digital Video Software?

What is Digital Video Software?
Digital Video Software allows you to download still images you recorded with the 
camcorder to a computer and manage, print, and edit them.

ZoomBrowser EX
• Viewing still images as thumbnails
• Managing by shooting date folders with still images
• Categorizing, organizing, and searching large volumes of still images
• Printing still images
• Editing still images
• Changing the data for still images and save them as new files
• Attaching still images to e-mail
• Viewing still images in a slide show
• Adding sound to a still image

CameraWindow
• Downloading still images from a memory card to your computer
• Viewing still images recorded on a memory card
• Printing still images recorded on a memory card without downloading the still 

images to the computer

TWAIN Driver (Windows 2000 only)
• Driver software that enables you to download still images from a memory card to 

a computer.

This instruction manual explains how to install the software, what you can do with the 
main features and how to operate them. For more detailed operational instructions, 
refer to the Help menu of each software program. 

Your camcorder may not support some features of the software.CO
PY
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Windows

CameraWindow
After you connect the camcorder to your computer, you can use CameraWindow to 
download still images on the memory card to the computer. Furthermore, you can print 
still images recorded on the memory card without having the images downloaded to 
the computer ( 42), and you can confirm and change the owner’s name of the 
camcorder you specify ( 85). Refer to When Connecting the Camcorder to a 
Computer ( 28) for launching the software. The Remote capture function is not 
supported by the camcorder.

[Acquire Images] Tab 
After you connect the camcorder to your computer, use this tab to download still 
images on the memory card to the computer.

Camera Control window 

Images will be downloaded to 
the computer, and ZoomBrowser EX 
starts. 

Images in the camcorder are 
displayed allowing you to select 
images. 

Placing a check mark here makes 
the Camera Control window to open 
automatically the next time you 
connect the camcorder.

Specify the image type to be downloaded and 
the destination folder. 

Selects a function in the Camera 
Control window.
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[Print] Tab
After connecting the camcorder to your computer, use this tab to print still images on 
the memory card without downloading them to the computer first. The window varies 
depending on the selected printing type. Refer to Printing Still Images Recorded on 
the Memory Card ( 42).

Prints all still images in the card 

one image per page.

Prints all still images in the card 

as an index page (rows of images 

with file names and image 

information).

Prints according to the DPOF print 

settings set by the camcorder to the 

still images recorded on the card.

Displays a list of the still images 

in the card, allowing you to select 

which ones to print.

Camera Control window 
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[Set to Camera] Tab
This tab is used for confirming and changing the owner’s name of the camcorder you 
can specify ( 85) and uploading the still images to the card. My Camera function is 
not supported by the camcorder.

Selecting [Manage My Camera] from the [Edit] menu displays the [My Camera] 
window. If you click [Creating My Camera data] in the [My Camera] window, 
[My Camera Maker] will be launched. [My Camera Maker] is a program that 
enables you to create and import My Camera contents (start-up images, start-
up sound, shutter sound, operation sound and self timer sound) to camcorders 
that support this function. Your camcorder does not support the My Camera 
function.

Uploading the images from the 
computer

Enter or change the name of 
the camcorder’s owner.

Camera Control window 
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Camera Browser Window 

If your camcorder supports wide size still image (16:9 such as 1920 x 1080 
pixels) recording, the thumbnails that appear in this window will be also 16:9 
images. The sample images used on this instruction manual are normal size 
still images (4:3).

Prints the selected still images.

Starts ZoomBrowser EX.

Selects the still image selection method.

Changes the size of the thumbnail.

Selects whether to show or hide the image 
frame and file name.

Still image information and a histogram

(This will not be displayed when using a card reader/writer.)CO
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Main Window
ZoomBrowser EX is a software program used for organizing, printing and editing the 
downloaded still images. If you wish to start ZoomBrowser EX without connecting the 
camcorder or card reader/writer, double-click the  on the desktop, or click the 
Windows [start] menu and select [All Programs]  [Canon Utilities]  [ZoomBrowser 
EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click  or select [Exit] from 
the [File] menu.

1 Task Area
[Acquire & Camera Settings]: Use this to display the Camera Control window to 

download still images, to print still images without 
having them downloaded to the computer and to 
configure the camcorder settings.

[View & Classify]: Use this to view and organize still images.
[Edit]: Use this to edit still images.
[Export]: Use this to change the data for still images and 

save them as new files, extract still images from 
movies, back up to CD-R/RW (Windows Vista/
Windows XP), or export shooting properties to a 
text file.

[Print & Email]: After you download still images to a computer, 
use this to print them or to attach them to e-mail 
messages.

1 

2 

3

 4

 5

 6

CO
PY



12 Windows

2 Folders Area
You can select a folder to be displayed in the Browser Area. In the [Last Acquired 
Images] panel, the newly downloaded still images are placed into virtual folders 
classified by recording date. In the panel below, the folders where the downloaded 
still images are actually saved in are displayed. Selecting the [Favorite Folders] tab 
shows only the folders that are registered as favorites. The [All Folders] tab shows all 
available folders.  indicates that newly downloaded still images are in the folder.
To register folders as Favorites, follow the instructions below.

To remove the registered folder, select the folder, and click [Remove].

3 Browser Area
This area displays the images contained in the selected folder. If you place the 
cursor over a thumbnail in the browser area,  will be displayed at the upper right 
corner. Clicking  skips over folders to zoom in directly on the intended folder.

Clicking on 2 images while holding down the [Shift] key selects also all 
images between the 2 images.
Clicking on different images while holding down the [Ctrl] key selects multiple 
images.

4 Image display control panel
The menu items vary depending on the View Mode.

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.
When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

1 Previous/Next Displays the previous/next image in the current folder.
2 Up Displays the folder in the upper tiers of the hierarchy. 
3 Select Allows you to select all images and deselects images.
4 Information Allows you to select the information to be shown. You can 

also hide the pop-up window by clearing the check box. 
The pop-up window appears when you move the pointer 
over a thumbnail.

5 Pan Changes the area displayed when you zoom in on a folder 
or image in the Browser Area and drags the thumbnail list.

6 Restore Display Size Changes the size of the thumbnail list to fit the window.
7 Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.
8 Filter Allows you to select which still images to display 

according to the star rating. When you download the 
images, the star rating is set to two stars as a default. To 
change the star rating, refer to Applying Star Ratings and 
Keywords ( 51).

2 3 4 81 65 7
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5 View Mode
You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

[Scroll Mode]: Double clicking a folder shows thumbnails of the still images inside.

[Preview Mode]: Double clicking the folders at the bottom of the window opens the 
folder and shows a large still image in the folder along with detailed information. 
You can change file name and comments. To display another image, click 
[Previous]/[Next] or select an image shown at the bottom of the window.CO
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6 Command buttons

1 View Image Displays a selected image in the [Image Viewer] window.
2 Properties Displays properties of the selected still image. When you 

select a different image while the [Properties] window is 
open, the information switches to the one of the selected 
image. The [Properties] window cannot be displayed in 
[Preview Mode].

3 Slide Show Displays still images in a slide show.
4 Search Allows you to search for images ( 56).
5 Delete Deletes selected images.
6 Rotate Rotates selected still images. A movie cannot be rotated.

1 2 3 4 5 6
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[Image Viewer] Window
The [Image Viewer] window appears when you select an image and click [View Image] 
or double-click an image.

1 Previous/Next Displays the previous/next image in the current folder.
2 Zoom In/Zoom Out Enlarges/Reduces a still image.
3 Pan When the image is larger than the window, you can move 

the image in the desired direction.
4 Print Prints the selected still image. Refer to [Photo Print] 

( 47).
5 Edit Allows you to perform the following operations: red-eye 

correction, auto correct, color and brightness correction, 
sharpness adjustment, trimming, inserting text, or 
registering external image editing applications.

6 Auto Focus Frame This function cannot be used for the images recorded by 
the camcorder.

7 Shooting 
Information

The shooting information of the image will be displayed.

8 Show Allows you to display multiple images at the same time.
9 Synchronize Synchronizes the View functions across all displayed 

images.

13 

15 

12 

11 

10 

14 

1 3 85 6 7 942
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Windows Vista: The star rating set using ZoomBrowser EX is not related to the 
“Rating” setting in Windows Photo Gallery and Windows Explorer.

[Red Eye Correction] Window
Select [Red Eye Correction] from the [Edit] menu, or click the  icon and 
select [Red Eye Correction]. Use this to correct still images in which people’s eyes 
appear red.

10 Fit to Window Matches the image size to the size of the Image Viewer 
Window.

11 Restore Restores the standard display size.
12 Zoom Slider Allows you to enlarge/reduce the displayed image.
13 Show Image Full 

Screen
Displays an image in full screen size.

14 Change the Star 
Rating

Allows you to change the star rating.

15 Capturing Frames Extracts still images from movies. 
(Windows Vista/Windows XP)

1 Auto Mode Clicking [Start] corrects the red eye effect automatically.
2 Manual Mode Point the cursor on a red eye so that the area is 

highlighted green, and click the mouse button.

 1

 2
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[Auto Adjustment] Window 
Select [Auto Adjustment] from the [Edit] menu, or click the  icon and select 
[Auto Adjustment]. Use this to automatically correct the color balance of the still 
image.

[Color/Brightness Adjustment] Window
Select [Color/Brightness Adjustment] from the [Edit] menu, or click the  icon 
and select [Color/Brightness Adjustment]. Use this to adjust the brightness, 
saturation, contrast, intensity levels, tone curve and RGB of the still image.

CO
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[Sharpness] Window 
Select [Sharpness] from the [Edit] menu, or click the  icon and select 
[Sharpness]. Use this to emphasize and clarify the outlines of people and objects.

[Trim Image] Window
Select [Trim] from the [Edit] menu, or click the  icon and select [Trim]. 
Specify the area in the still image to crop and click [Trim Image] to trim the image.
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[Insert Text] Window 
Select [Insert Text] from the [Edit] menu, or click the  icon and select [Insert 
Text]. Use this to write text on still images.

These image correction tools can be selected by clicking [Edit]  [Edit Image] 
in Task Area of the Main Window.
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20 Installing the Digital Video Software

Installing the Digital Video Software
Be sure to install the Digital Video Software before connecting the 
camcorder to the computer.
You must have authorization as a Computer System Administrator to install 
programs.

Windows Vista/Windows XP Users:
Your digital video camcorder is equipped with the standard Picture Transfer 
Protocol (PTP). This protocol enables you to download still images by simply 
connecting the camcorder to a computer with the USB cable (applications such 
as the [Scanner and Camera Wizard] start automatically).
However, note that there are several limitations to downloading still images 
with this method. To avoid these, install ZoomBrowser EX to download still 
images.

It may take a few minutes, after connecting the camcorder, until you can 
download still images.
Still images protected on the camcorder may lose this setting once they are 
downloaded to the computer.

1 Check that the camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be 
installed normally. If a camcorder is connected, detach the USB cable from the 
computer.

2 Set the DIGITAL VIDEO Solution Disk in the computer’s CD-
ROM drive.

• Windows Vista: When the [AutoPlay] window appears, click [Run 
SETUP.EXE]. Follow the instructions in the [User Account Control] window 
that appears after a brief period.

• Windows XP/Windows 2000: The installer panel appears automatically.
• If the installer panel does not open automatically, use the following procedures 

to display it. 
- Windows Vista:

1) Select [Computer] from the Start menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu.
3) Double-click the [setup.exe] icon.
4) Follow the instructions in the [User Account Control] window that 

appears.
- Windows XP:

1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu.
3) Double-click the [SETUP.EXE] icon.

- Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu. 
3) Double-click the [SETUP.EXE] icon. 
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Depending on your computer’s settings, the file extension “.EXE” may not 
appear.

3 Select your country or region.

4 Select your language.

5 Click [Easy Installation] under Digital Video Software.
To install the software individually, click [Custom Installation].

6 If other software is running, close all programs and click 
[OK].

Installer Panel 
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22 Installing the Digital Video Software

7 Review the installation settings and click [Install].
If you selected [Custom Installation] and are using Windows 2000, select Canon 
DV TWAIN Driver (USB driver).

When installing the software on Windows XP or 2000 by selecting [Easy 
Installation], EOS Utility (software for downloading still images from the Canon 
EOS Digital SLR Cameras) will be installed. This software is used only for 
compatible Canon EOS Digital SLR Cameras, and the camcorder does not 
support this software.
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8 Read the license agreement and click [Yes] to accept the 
terms and to start installation.

9 Click [Next].
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24 Installing the Digital Video Software

10When the installation is complete, make sure [Restart 
computer immediately (Recommended)] is selected and 
then click [Restart].

When you do not need to restart the computer, the [Finish] screen will be 
displayed. Click [Finish]; remove the DIGITAL VIDEO Solution Disk from the 
CD-ROM drive, and proceed to Before Downloading Still Images ( 25).

11When the computer has restarted and the regular desktop 
screen is displayed, remove the DIGITAL VIDEO Solution 
Disk from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO Solution Disk before 
you connect the camcorder to the computer.

Windows 2000: At this point, the files for the TWAIN Driver have only been 
copied to your computer. To download images via USB connection, finish 
installing the TWAIN Driver. For details, see step 4 ( 25) in Connecting the 
Camcorder to a Computer.
CO
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Before Downloading Still Images

Connecting the Camcorder to a Computer
Be sure to install the Digital Video Software before you connect the 
camcorder to the computer.
Make sure the camcorder is being powered using the power adapter before 
connecting it to a computer.
Connect the USB cable directly to one of the computer’s main USB ports. 
The interface may not function correctly if the camcorder is connected via a 
USB hub.
The connection may not operate correctly if you are using other USB 
devices, excluding USB mice or keyboards, at the same time. If this occurs, 
disconnect the other devices from the computer and try reconnecting the 
camcorder.
Do not connect two or more camcorders to the computer. The camcorders 
may not operate normally.
Never allow the computer to go into standby (sleep) mode while a 
camcorder is connected via the USB interface. 

Refer to your computer manual for the location of the computer’s USB ports. 
See your camcorder instruction manual for connecting instructions.

1 Insert a memory card containing images into the camcorder.

2 Connect the power adapter to the camcorder. 

3 Set the camcorder to still image playback mode.
Wait until the card access indicator stops flashing.

4 Attach the supplied USB cable to the computer’s USB port 
and the camcorder’s USB Terminal.

• The first time you connect the camcorder to the computer:
- Windows 2000: Installation of the DV TWAIN Driver starts. If the “Digital 

signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.

• A window appears allowing you to select an application program to start.
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• For instructions on how to start ZoomBrowser EX and download images to the 
computer, see Downloading Still Images ( 27).

USB CableUSB Terminal 
on the Camcorder

 Camcorder End Computer End 

USB Port on 
the Computer
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Downloading Still Images
Observe the following precautions when the camcorder’s access indicator is 
flashing. Failure to do so may cause memory card data to become 
corrupted.
- Do not remove the memory card or detach the USB cable.
- Do not turn off the camcorder or the computer.
- Do not change the position of the POWER or the TAPE/CARD switches.
Images recorded onto memory card or downloaded to the hard disk are 
important original data files. Create a copy of the file first before working on it 
on your computer.
Do not rotate the image using programs other than ZoomBrowser EX. The 
data for the original image will be changed and the image can no longer be 
displayed in ZoomBrowser EX or on the camcorder. 
If the Server Busy window appears when you connect the camcorder to the 
computer, click [Retry].
You cannot connect the camcorder to a computer if the memory card 
contains 1800 images or more. In this case, use a card reader/writer to 
download images.
- For instructions on how to connect a card reader/writer, see Using a Card 

Reader/Writer ( 38).
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When Connecting the Camcorder to a Computer

1 Connect the camcorder to the computer ( 25).

2 Select [Canon CameraWindow] and click [OK].
• Windows Vista: When the [AutoPlay] window appears, click [Downloads 

Images From Canon Camera using Canon CameraWindow].
• If a camcorder and card reader are connected at the same time, a dialog 

appears allowing you to select the camcorder model. Confirm that [Canon 
Camera] or your camcorder model name is displayed and click [OK].

• The Camera Control window opens.

If the camcorder is already connected to the computer, you can start the 
CameraWindow and display the Camera Control window by clicking [Acquire 
& Camera Settings] followed by [Connect to Camera] in the ZoomBrowser 
EX Main Window.
The Remote shooting function is not supported by your camcorder.
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Using the Computer to Download Still Images 
(CameraWindow)

You can select a downloading method in the Camera Control window.

Auto-Downloading

1 Click [Starts to download images] in the Camera Control 
window.

• For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ( 30).

• Click [Finish] to close the Camera Control window after downloading images.
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Auto-Downloading Settings
Select the setting for downloading images by operating your computer. You can 
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images] 
tab and click [Preferences].

2 Select [Change auto download settings] and click [Next].
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3 Select the image type to be downloaded and click [Next].

4 Specify the destination folder settings and click [Next].

Place a check mark here 
if you wish the original image 
in the memory card to be 
deleted after downloading.

Click this button 
to specify the 
destination folder.  

Destination Folder  

Select to specify  
the name of the 
subfolder.
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5 Specify a process to perform after the image is downloaded.

The window below will be displayed when you select [Perform selected 
processes consecutively] (you can redisplay the window by clicking [Select]). 
Select a process to perform after the image is downloaded, and click [OK].
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6 Click [Finish].

Downloading the Selected Still Images from the CameraWindow

1 Click [Lets you select and download images] in the Camera 
Control window.

The CameraWindow opens.

Placing a check mark  
here makes images in  
the camcorder to be 
automatically downloaded  
when the camcorder is 
connected.
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2 In the CameraWindow, select the image you wish to 
download and click [Image Download].

• Clicking on 2 images while holding down the [Shift] key selects also all images 
between the 2 images.

• Clicking on different images while holding down the [Ctrl] key selects multiple 
images.

3 Confirm the settings and click [Starts Download].
• ZoomBrowser EX starts, and the downloaded images appear in the Main 

Window. 

• To make changes, click [Change Settings].

A blue frame 
appears around 
the selected image.

Settings for the file prefix  
and the consecutive numbers

Settings for the folder and the
subfolder for downloaded images
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[Specify Folder] Tab

[Specify File Name] Tab

Specify the settings of 
the folder and subfolder.

Specify the file name with 
which to save the images.
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Using the Camcorder to Download Still Images (Direct 
Transfer Function)

If your camcorder supports the Direct Transfer function, you can use the camcorder to 
download images.

Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images] 
tab and click [Preferences].

2 Select [Change direct transfer download destination folder] 
and click [Next].CO
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3 Specify the destination folder settings and click [Finish].

Direct Transfer

1 Select a transfer option on the camcorder screen and press 
the  button.

• See your camcorder instruction manual for how to set and operate the 
camcorder to transfer images.

• The  button cannot be used when it is not lighted.
• You can set the action that is carried out for direct transfer. Right-click the 

[CameraWindow(Launcher)] icon on the taskbar and select an action from the 
displayed menu.
- [Show image(s) in fullscreen 

mode]:
Displays downloaded images in 
full screen mode.

- [Launch ZoomBrowser EX]:
Starts ZoomBrowser EX after 
downloading the images.

- [Show Window]: 
The Camera Control window 
appears when you connect the 
camcorder to the computer.

Click this button 
to specify the 
destination folder.  

Destination Folder  

Select to specify  
the name of the 
subfolder.
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Using a Card Reader/Writer
The basic operations are the same as when you connect the camcorder to the 
computer. Follow the procedure below to open the CameraWindow. For instructions 
on how to connect the card reader/writer, refer to its manual.

If your card reader/writer does not support miniSD cards, please purchase an 
appropriate adapter for the card. If you are using SDHC cards, you need to use 
a card reader/writer compatible with SDHC cards.

1 Insert a memory card containing images recorded with the 
camcorder into the reader and connect it to the computer.

• Windows Vista/Windows XP: When a window appears allowing you to select 
an application program to start, select [View/Download Images using Canon 
ZoomBrowser EX] and click [OK].

• Windows 2000: Click the Windows [Start] menu, and select [Programs], 
[Canon Utilities], [ZoomBrowser EX Memory Card Utility] and [Canon 
ZoomBrowser EX Memory Card Utility].

Clicking [Acquire & Camera Settings]  [Acquire Images from Memory Card] 
in the Main Window of ZoomBrowser EX also opens the image download 
window.

 2 Select a downloading method.
• [Download Images]: A progress bar will be displayed and images will be 

downloaded to the computer, and ZoomBrowser EX starts. For instructions on 
how to set the Auto-download settings, see Auto-Downloading Settings 
( 39).

• [Lets you select and download images]: The ZoomBrowser EX opens, 
displaying the still images on the camcorder’s memory card as thumbnails 
(small images).CO
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Using the Computer to Download Still Images 
(ZoomBrowser EX)

Select a download method in the image download window.

Auto-Downloading

1 Click [Download Images].
• For instructions on how to set the Auto-download settings, see Auto-

Downloading Settings ( 39).
• Click [Exit] to close the window after downloading images.

Auto-Downloading Settings
Select the setting for downloading images by operating your computer. You can 
change the image type and the destination folder.

1 Click [Preferences].
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2 Configure the settings and click [OK].

The window below will be displayed when you select [Perform selected 
processes consecutively] or [Select] under [Action After Download]. Select a 
process to perform after the image is downloaded, and click [OK].
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Downloading the Selected Still Images from the ZoomBrowser 
EX

1 Click [Lets you select and download images].
The ZoomBrowser EX opens.

2 In the ZoomBrowser EX, select the image you wish to 
download and click [Image Download].

• Clicking on 2 images while holding down the [Shift] key selects also all images 
between the 2 images.

• Clicking on different images while holding down the [Ctrl] key selects multiple 
images.

A blue frame 
appears around 
the selected image.CO

PY
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Printing Still Images

Printing Still Images Recorded on the Memory Card
This section explains how to print still images by connecting the camcorder to the 
computer. The steps are basically the same when using a card reader/writer.
You can select one of the following 4 methods to print still images in the card without 
downloading images to the computer.
• [Print All Photos]

- Prints all still images recorded on a memory card in the connected camcorder or in 
a card reader/writer one image per page.

• [Print Contact Sheet with All Photos]
- Prints all still images recorded on a memory card in the connected camcorder or in 

a card reader/writer in an index (rows of images with file names and image 
information).

• [Print according to DPOF settings]
- Prints according to the DPOF print settings set by the camcorder.

• [Select an image and print]
- A list of the still images recorded on a memory card in the connected camcorder or 

in a card reader/writer will be displayed, and you can select images you wish to 
print.

1 Connect the camcorder to the computer. ( 25)

2 Click the [Print] tab in the Camera Control window.
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3 Click one of the 4 printing methods.

4 Specify the print settings and click [Print].
The window varies depending on the selected printing method in step 3.
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When you have selected [Print All Photos]:

Selects the printer. Sets the paper size and type.

Sets the shooting date/time 

imprint and color settings.

Click this button to switch between still images 

if multiple images are selected. 

Sets the number of print copies of the displayed image.CO
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When you have selected [Print Contact Sheet with All Photos]:

When you have selected [Print according to DPOF settings]:
• The selected still images will be printed according to the number of copies set with 

the camcorder. The same window described in the previous section When you have 
selected [Print All Photos]: ( 44) will be displayed.

Rotates still images.

Click this to use the trimming function  
(crops a portion of the still image).Selects the printer.

Sets the paper size 
and orientation.  

Click these buttons to switch between pages.Sets the print settings 

for shooting information, 

comments, headers, 

footers and page 

numbers.

Sets the number of print copies of the contact sheets.

Sets the number of rows and columns.

CO
PY



46 Printing Still Images

When you have selected [Select an image and print]:
• If you selected [Select an image and print], the following window will be displayed. 

Select still images you wish to print, and click [Print]. If you selected [Contact Sheet 
Print], the same window described in the previous section When you have selected 
[Print Contact Sheet with All Photos]: ( 45) will be displayed. If you selected [One 
Photo Per Page Print], the same window described in the previous section When you 
have selected [Print All Photos]: ( 44) will be displayed instead. Set the print 
settings and print the still images.
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Printing Still Images Downloaded to the Computer 
You can select one of the following 2 methods to print still images downloaded to the 
computer.
• [Photo Print]

- Prints one still image per page.
• [Index Print]

- Prints selected images in rows with file names and image information.

You can select the program to use for printing by clicking [Print & Email] in the 
Main Window and selecting [Print Using Other Software].

[Photo Print]

1 Click [Print & Email] in the Main Window and click [Photo 
Print].

2 Select still images you wish to print and click [Printer and 
Layout Settings].CO

PY
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3 Specify the print settings and click [Print].

Click this button to switch between still  
images if multiple images are selected.

Selects the printer.

Sets the shooting date/time imprint and color settings.

Sets the paper size settings. 

Sets the number of print copies 

of the displayed image.
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[Index Print]

1 Click [Print & Email] in the Main Window and click [Index 
Print].

2 Select the still images you wish to print and click [Printer 
and Layout Settings].
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3 Specify the print settings and click [Print].

Click these buttons to switch between pages.

Selects the printer.

Rotates still images.

Sets the print settings for shooting information, 
comments, headers, footers and page numbers.

Sets the paper size and orientation. 

Sets the number of print copies of the contact sheets.

Sets the number of rows and columns.

Click this to use the trimming 
function (crops a portion of 
the still image).
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Organizing Images

Applying Star Ratings and Keywords
This task allows you to apply ratings to your images from one star to three stars. The 
star rating can be used as one of the search conditions, or for the selection of images 
to be displayed in the Browser Window. The keyword can be used as one of the 
search conditions.

1 Select the image to which you wish to apply the star rating 
or keyword, and select [View/Modify Keywords] from the 
[Tools] menu.

2 Place a check mark next to the keyword you wish to apply, 
or click on the stars for rating.

The default setting of the star rating is two stars.
You can add and delete keywords, or change the keyword list in the [Manage 
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
Windows Vista: The star rating set using ZoomBrowser EX is not related to 
the “Rating” setting in Windows Photo Gallery and Windows Explorer.
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Classifying the Images
This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

2 Click [Classify into Folder].

3 Select the images you wish to classify and click [Specify 
Classification Settings].CO

PY
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4 Specify the folder structure and the saving folder and click 
[Finish].

The selected images are classified into the specified folder.
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Renaming Multiple Files
This task allows you to rename multiple files at the same time, or to rename and copy 
multiple files.

1 Click [View & Classify] in the Main Window.

2 Click [Rename Multiple Files].

3 Select the images you wish to rename and click [Specify 
Rename Settings].CO
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4 Specify the settings and click [Finish].

To rename a folder, select a folder, and open the [Rename Folder] window by 
selecting [Rename] from the [File] menu. Input the new name, and click [OK].

Placing a check mark here makes copies of images with new names.  
The name of the original images will not be changed.
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Searching for Images
This task allows you to search for images by star rating, modification date, shooting 
date, comment or keywords.

1 Click [View & Classify] in the Main Window.
You can also search for images by clicking [Search] on the Application Tool Bar. 
Skip to step 3.

2 Select folders and images from which you wish to search 
and click [Search].
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3 Specify the search conditions and click [Start Search].
• The search results are displayed as thumbnails.
• Select at least one search condition.

4 Click [Finish].
• To change the search parameters and perform another search, click [Specify 

Search Conditions] and repeat steps 3-4.CO
PY
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• The images of the search result are displayed in the [Search Results] folder. 
You can print or copy these images to another folder.

The searched images will remain in this folder until ZoomBrowser EX is closed 
or another search is performed, but if you delete an image in this folder, the 
corresponding original image will be deleted as well.

Folders Area
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Creating a Movie from the Still Images

Editing Movies
You can link still images, insert text and background music, and add effects. You can 
also change the size of selected movies and save them as new files.

If you are using Windows 2000, QuickTime is required to edit movies. If it is 
not already installed on your computer, install it from the DIGITAL VIDEO 
Solution Disk. Place the disk in the CD-ROM drive and click [Install] under 
QuickTime in the installer panel.
If you have an AVI file in your computer, you can use this function to edit the 
file.

1 Click [Edit] in the Main Window.

2 Click [Edit Movie].

3 Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.
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4 Arrange images and click [Apply Effect].
To change the order of images, select an image in the Storyboard Area and click 
[Move Left] or [Move Right].

Storyboard Area
Displays thumbnails of the 
selected images. The images will 
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.

Plays back the movies
being edited.
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5 Apply effects to the images and click [Set Audio].
When you select [Apply effects to image.], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text, 
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter 
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.
- [Transition Effect]: Opens the [Transition Effect Settings] window. You can 

set the transition effect type and display time, and preview the effect. To set 
a transition effect, you need to select a transition box in the Storyboard Area.

6 Set the audio and click [Save].
When you select [Set audio.], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add an MP3 or a WAV 
file as background music. 

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can 
adjust the audio level of a movie or an audio file and apply audio faders. To 
set the advanced audio settings, you need to select a movie or an audio file 
which you added.
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7 Click [Save].
Movies are saved in DCF type files with Motion JPEG/AVI compression.

8 Click [Exit].

Select this to save as Motion JPEG compressed AVI.

Selecting [Specify a save image type] and clicking [Advanced Settings] allows 
you to set [Image Size], [Frame Rate] or [Audio] settings of the movie.
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Playing Back Movies
In the CameraWindow and Main Window, movies are displayed with the first scene as 
a still image with a  (movie) icon.

If you are using Windows 2000, QuickTime is required to play movies. If it is 
not already installed on your computer, install it from the DIGITAL VIDEO 
Solution Disk. Place the disk in the CD-ROM drive and click [Install] under 
QuickTime in the installer panel.
Do not double-click a movie file (.AVI extension) in Windows Explorer. That 
will start Windows Media Player, which may not support this file type. To play 
back movies, double-click the thumbnail with a movie icon in the Main 
Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a  
(movie) icon.

[Image Viewer] window appears.
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• The [Image Viewer] window is displayed, and the movie will be played back. 
You can control (play back/stop/fast forward/rewind) the movie being played 
back with the buttons shown at the bottom left of the window.

• Windows Vista/Windows XP: You can extract still images from movies and 
save them as image files. For details, refer to Extracting Still Images from 
Movies (Windows Vista/Windows XP) ( 72).

You can play movies and control the sound volume.

You can save the displayed scene as a still image.
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Exporting Images
You can change the data type for selected still images and movies and save them as 
new files. You can also export selected movies and still image properties to a text file 
or copy and rename movies and still images. Furthermore, you can export still images 
for use as a screen saver or a wallpaper.

Changing the File Type and Saving

1 Click [Export] in the Main Window.

2 Select the export type.
If you selected [Export Movies], [Extract frames from a movie] or [Backup to
CD], refer to the pages listed below.
[Export Movies]: Exporting Movies ( 69) 
[Extract frames from a movie]: Extracting Still Images from Movies (Windows 
Vista/Windows XP) ( 72)
[Backup to CD]: Saving on CD-R/RW Disks (Windows Vista/Windows XP) 
( 75) CO
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3 Select images and click [Specify Export Settings].

4 Specify the export settings and click [Finish].
The window varies depending on the selected export type in step 2.

When you have selected [Export Still Images]:
You can convert still images to another file type, resize and save them as new files. 
You can select the file type from BMP, JPEG and TIFF. You can also specify a prefix to 
be added to the exported still images.
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When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.
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When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be 
performed if you have selected multiple images.
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Exporting Movies
You can change the size or file type for selected movies and save them as new files.

If you are using Windows 2000, QuickTime is required to export movies. If it is 
not already installed on your computer, install it from the DIGITAL VIDEO 
Solution Disk. Place the disk in the CD-ROM drive and click [Install] under 
QuickTime in the installer panel.

1 Click [Export] in the Main Window.

2 Click [Export Movies].
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3 Select a movie and click [Select the save image type].
You can select multiple images or a folder to include all images in that folder.
Still images cannot be selected. For instructions on how to export still images, 
see Exporting Images ( 65).

4 Select a file type and click [Set the save image type].

5 Specify the export settings and click [Specify name of file to 
be saved].
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6 Specify the file name and click [Start export].
In each case, specify the destination folder and file name of the movie to be 
exported.

7 Click [OK].
The Main Window appears.

Destination Folder
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Extracting Still Images from Movies (Windows Vista/Windows XP) 
You can extract still images from movies and save them as image files.

1 Click [Export] in the Main Window.

2 Click [Extract frames from a movie].

3 Select the movie from which you wish to extract still images 
and click [Set extraction method].

CO
PY



73Exporting Images

W
in

do
w

s

4 Select the still images extraction method and click [Preview 
image].

• [Extract all frames]: Extracts all frames in the movie as still images.
• [Specify an interval and extract frames]: Extracts frames as still images from a 

specified frame range or time interval.
• [Specify the number of copies and extract frames]: Extracts a specified 

number of still images from the entire movie. The extraction interval is 
calculated based on an equal distribution of the specified number of still 
images.

• [Extract a specified image]: Extracts still images from scenes that catch your 
attention.
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5 Confirm the still images which will be extracted (images with 
check marks) and click [Set up save].

If you selected [Extract a specified image] in the previous window, the movie will 
be displayed in the upper part of the window. Display the images you want and 
click [Add].

6 Specify the file name and the folder where you wish to save 
it and click [Perform processing].

 : Rotates all still images.

 : Clears or adds check marks to all still images at once.

 : Clears the check marks of all the still images before/after the 
selected still images.

 : Changes the thumbnail size.CO
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Saving on CD-R/RW Disks (Windows Vista/Windows XP)
You can copy and save images to CD-R or CD-RW disks. The shooting information is 
copied along with the images.

This function can only be used on a computer that came with a CD-R/RW drive 
as standard equipment.

1 Place a CD-R/RW disk in the computer’s CD-R/RW drive.

2 If the following window appears, click [Cancel].

3 Click [Export] in the Main Window.
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4 Click [Backup to CD].

5 Select the folders or images you wish to save and click 
[Specify Backup Settings].
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6 Set the backup settings and click [Start Backup].
The disk will be ejected from the drive when copying is complete.

You can add images to a CD-R/RW disk that already contains images.
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Adding Still Images to the Memory Card
You can add still images (JPEG) from the computer to a memory card in the 
camcorder or card reader/writer.

Adding Still Images to the Memory Card in the Camcorder

1 Connect the camcorder to the computer ( 25).

2 Click the [Set to Camera] tab and click [Uploads images to 
the camera].

3 Select the still images you wish to save and click [Open].CO
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4 Select the image size and click [Add].

When you upload images edited with another application, image properties 
may be lost.
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Using Various Functions

Attaching Still Images to E-mail Messages
You can attach selected still images to an e-mail message. If necessary, you can make 
the image file size smaller.

1 Click [Print & Email] in the Main Window.

2 Click [Email Images].

3 Select the still images you wish to send and click [Change 
Image Size].
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4 Select image size and quality, and click [Finish].
• If you selected [Using the recommended settings.], your e-mail software starts 

and the selected still images appear as an attachment in the message 
window. Input address, subject and your comments and send the message.

• E-mail software not supporting MAPI does not start automatically. In this case, 
select [Save to Folder] in the [Custom Settings] screen and select a 
destination folder for the still images.

• If you select [Using custom settings.], change the settings in [Custom Settings] 
and click [OK].

To use this function, the e-mail software must be enabled as MAPI client. For 
details, refer to the instruction manual of the e-mail software.
This function uses the e-mail software configured in [Internet Options]. To 
change the software, first exit ZoomBrowser EX. Next, in Internet Explorer, 
select [Tools], [Internet Options] and the [Programs] tab. Set the desired 
software in [E-mail] and click [OK]. (This procedure may change depending 
on your Web browser.)
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Running a Slide Show
You can view selected still images in a slide show.

1 Click [View & Classify] in the Main Window.
You can also view a slide show by clicking [Slide Show] on the Application Tool 
Bar. Skip to step 4.

2 Click [View as a Slide Show].

3 Select the images and click [Setup Slide Show].CO
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4 Select the slide show settings.
• [Image Size]: Select the size of the still images.
• [Image Information]: Select to show image information such as file name or 

title.
• [Advance to Next Slide]: Select to advance manually or automatically. When 

you select “Every 3 second(s)”, you can select the interval in the control below 
(from 1 to 120 seconds).

• [Loop]: Select to stop the slide show after the last image or to continuously run 
it in a loop.

• [Transitions]: Select the transition effect to be used when moving from one 
slide to another. When you click an effect, you can check the effect in the 
preview window. 

5 Click [Start Slide Show].
Click  in the lower right corner to end the slide show.CO
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Adding Sound to a Still Image
• You can add a sound to an image. The sound file that can be added to the image 

must be WAVE type (extension “.wav”).
• The sound cannot be played back on the camcorder.

1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

2 Click [Add]. 

3 Select the sound file and click [Open].

4 Click [OK].
• The sound file will be copied to the same folder as the image. 
• To play back the sound, select an image with a sound icon and select [Play 

Sound] from the [Edit] menu.

To remove sound from an image, select [Remove] on the Sound window in 
step 2.  disappears and the copied sound file will be deleted.
The [Play Sound] window appears and plays back the sound.
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Reviewing and Changing the Owner Name of the 
Camcorder

You can change and confirm the owner’s name of the camcorder.

1 Connect the camcorder to the computer ( 25).

2 Click the [Set to Camera] tab and click [Confirms/changes 
camera settings].

3 Enter the camcorder’s owner’s name and click [OK].

Input the camcorder’s owner’s 
name here (up to 31 characters).
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Uninstalling the Software
Uninstall the software when you wish to delete it from your computer or when 
reinstallation is required to fix corrupted files.

You must have authorization as a Computer System Administrator to uninstall 
programs.

Uninstalling ZoomBrowser EX
Other programs in the [Canon Utilities] folder can also be uninstalled in the same way.

1 Click the Windows [start] menu and select [All Programs]  
[Canon Utilities]  [ZoomBrowser EX] and [ZoomBrowser 
EX Uninstall].

Uninstall all programs in [Canon Utilities] when you have uninstalled 
ZoomBrowser EX.
RAW Image Task is used with Canon digital camera. The camcorder does 
not support the program, but you can uninstall the program in the same way 
as uninstalling the ZoomBrowser EX.
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Uninstalling the TWAIN Driver (Windows 2000 only)

1 Connect the camcorder to the computer ( 25).

2 If a window for selecting an application program or the 
Scanners and Cameras Wizard appears, click [Cancel]. If 
ZoomBrowser EX started, close it.

3 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

4 Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver 
Uninstallation ( 89).

5 Delete [Canon Camera] from the [Scanners and Cameras 
Properties] list.

6 Click [OK] to close the window.

7 Turn the camcorder POWER switch to OFF and remove the 
USB cable from the computer.

8 Click the Windows [Start] menu and select [Programs], 
[Canon Utilities], [DV TWAIN Driver x.x] and [TWAIN Driver 
Uninstall].

A version number appears in place of “x.x”.

9 When the Confirm Uninstall window appears, click [OK]. 
The uninstall process starts.

10When the Maintenance Complete window appears, click 
[Finish].
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Troubleshooting
Connection

Camcorder is not recognized when connected to the computer.
Computer does not support the USB interface.
Refer to System Requirements ( 5).
There is no memory card in the camcorder.
Insert a memory card into the camcorder.
The camcorder is not set to the correct mode.
Set the camcorder to still image playback mode.
Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ( 25) and check the 
connection. 
Ensure that you are using the correct cable and that its connectors are in good 
shape.
If you are experiencing operational problems, detach the USB cable from 
the camcorder and computer and terminate the connection. Restart the 
computer and then reconnect the camcorder.
TWAIN Driver is not installed properly.
First uninstall the TWAIN Driver, then reinstall the driver from the DIGITAL 
VIDEO Solution Disk (remove the check marks from the other programs when 
prompted to select the programs to be installed).

ZoomBrowser EX Operation
Cannot download still images.

The camcorder is not set to the correct mode.
Set the camcorder to still image playback mode.

Image files or folders do not appear in ZoomBrowser EX.
Images or folders shown in ZoomBrowser EX and the actual file contents 
may be different when an image file has been moved or copied using 
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

TWAIN Driver Installation 
Cannot install the TWAIN Driver correctly.

Does the system have a built-in USB port and did it come with Windows 
2000 preinstalled? Refer to System Requirements ( 5).
Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ( 25) and check the 
connection.
Ensure that you are using the correct cable and that its connectors are in good 
shape.
Are you using the power adapter to power the camcorder?
If the problem is not mentioned above, the TWAIN Driver may not have 
been recognized by Windows. 
Uninstall and reinstall the driver.
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TWAIN Driver Uninstallation 
If you have problems when uninstalling the driver, use the following procedure to 
remove it. Leave the camcorder connected to the computer.

The [Inf] folder contains numerous files that are critical to the computer’s 
operation. Be extremely careful not to delete the wrong files. If you delete the 
wrong file, you may be unable to restart Windows.

Use the procedure below for the following circumstances too.
- If you do not find [Scanners and Cameras] in the [Control Panel] or 

[Printers and Other Hardware].
- If [Canon Camera] or your camcorder model name does not appear in the 

[Scanners and Cameras Properties] or [Scanners and Cameras].
- If you connected the camcorder to the computer via the USB cable before 

installing the Digital Video Software.

1 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

2 Double-click the [System] icon.

3 Click the [Hardware] tab.

4 Click the [Device Manager] button.

5 If [Canon Camera] or your camcorder model name appears 
under the [Other Devices] and/or [Imaging Devices] 
categories, use the following procedure to delete it.

1. Select [Canon Camera] or the name of the camcorder model, right-click the 
mouse button and select [Delete].

2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

Remove all copies of [Canon Camera] or your camcorder model name that 
appear in the [Other Devices] or [Imaging Devices] categories, or that appear 
more than once in one category.

6 Double-click the [My Computer] icon on the desktop, 
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedure to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders] category 

to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.
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7 Look for the file for Canon digital camcorders starting with 
[Oem*].

• A number such as “0” or “1” will appear in place of the asterisk (*) above. You 
will also find another file called [Oem*.pnf], which will have the same number 
as the [Oem*.inf] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click an [Oem*.inf] file, the Windows Notepad program will start 

and show the file contents. Click each [Oem*inf] file until you find one that 
contains “*** Canon Camera Driver Setup File***” in its first line. When you 
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.
Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct 
files.

If You Were Using ZoomBrowser EX Version 2 or 3 
(This manual explains version 6.x)

Titles and comments added using a prior version than ZoomBrowser EX 
version 4 do not appear in ZoomBrowser EX 4 or higher.

Titles and comments added using a prior version of ZoomBrowser EX will 
not be displayed. Use the following procedure to display them.
1. In Windows Explorer, open the [Program] folder under the folder in which you 

installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbconverter.exe].
3. Select the database you were using until now (C:\Program Files\Canon\

ZoomBrowser EX\Program) and click the [Start] button.
Note that with ZoomBrowser EX 4 or higher, both titles and comments appear 
in the comment list.

Cannot find the image folders saved with a prior version than ZoomBrowser 
EX 6.x.

Image folders saved under the [Program Files] folder (such as [Image 
Library One]) cannot be displayed in the Main Window’s Folder Area of 
ZoomBrowser EX 4 or higher. Use the following procedure to display 
them.
1. In Windows Explorer, open the [Program Files] folder under the folder in 

which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\Image Library One).

2. Select the image folder you wish to display and copy the folder to a different 
destination.
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